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Tonality: Howard Benson has been developed to capture every song aspect of what makes the duo’s guitar tones 
so distinctive. The plugin suite takes your direct input guitar signal all the way to a fully mixed guitar tone with its 
unique all-in-one design. 

Experience an all-access pass to Benson and Plotnikoff’s mix-ready guitar tones from some of their biggest-selling 
records. For over 20 years, Howard Benson and Mike Plotnikoff have been the vanguard instrumentalists for some of 
rock n’ roll's biggest names, including Bon Jovi, My Chemical Romance, The All-American Rejects, Hoobastank, 
Three Days Grace, P.O.D, Daughtry and Papa Roach.

Chris Lord-Alge: Trilogy Preset Pack

STL Tones brings 5-time GRAMMY® award-winning mix engineer Chris Lord-Alge’s guitar tones to life with a one-of-
a-kind preset pack to use within the Tonality: Howard Benson plugin.

Chris Lord-Alge is known for collaborating with Howard Benson, who has produced the plurality of the albums Lord-
Alge has mixed. The ’Trilogy’ team award-winning engineer/mixer Mike Plotnikoff, GRAMMY®-nominated producer/
engineer/mixer, and multi-instrumentalist Howard Benson and Chris Lord-Alge have been working on records 
together since 1998, before they were even doing digital records. These artists include Santana, Less Than Jake, 
Zebrahead, P.O.D., Crazytown, Breaking Benjamin, Bon Jovi, Papa Roach, Hoobastank, Theory of A Deadman, 
Daughtry, The All American Rejects, Three Days Grace, Saosin, Seether, My Chemical Romance, Halestorm, Skillet 
and many more.



System Requirements                                                                                                                           Page  5

• Tonality: Howard Benson comes in 64-bit VST3, VST2, AU, AAX, and standalone plugin formats.

• Latest OS Compatibility for Windows & Mac, including Native Apple Silicon

• Minimum Requirements Mac OS 10.13 or Windows 7

• STL Licensing System, no iLok account required.

• 3 activations are available per user.

NOTE: During recording or monitoring, we recommend a buffer size of 128 samples or lower. This low buffer size is to 
minimize latency and improve the play-through experience. This can be set in your audio interface setup utility or your 
DAW audio settings.
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Tonality: Howard Benson is available in the following plugin formats, compatible with the noted Digital Audio 
Workstation (DAW) platforms:

- VST3, VST2 (Cubase, Studio One, Ableton Live, and Reaper)

- AU (Logic, Garage Band, and Luna)

- AAX (ProTools)

Tonality: Howard Benson software can also be used as a standalone application. The Standalone version is perfect 
for practice on the go and for use in live situations.
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• Always use the high impedance (Hi-Z) input of your interface. This will ensure less noise and signal loss. Most 
analog (pre)amplifiers and stomp boxes have an input impedance of 1MegaOhm, so the best practice would be to 
match the 1MegaOhm input impedance on your interface when using this plugin.

• Always make sure to have the highest input signal before the AD conversion, avoiding clipping.

• Amp and stomp box simulators are not noisy, they do not add noise. They’re a lot less noisy than analog hardware. 
If you have noise issues, check your guitar’s electronic circuit, cables, and sound-card settings.

• In almost all cases, amp and stomp box simulators do not introduce noticeable latency. Tonality: Howard Benson 
doesn’t introduce any noticeable latency. If you’re experiencing latency issues, check your interface settings. 
Experiment with your input buffer size. We recommend a setting of 128 samples. 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STL Tones Download Center

Please visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product. 

STL Tones License System

• Your Activation License code will be in the confirmation email you received after your purchase.  

• To login into your user account, go to www.stltones.com and click on the “Login” icon in the upper right-hand corner. 
If you don’t have a user account, create one by clicking “Create Account” inside the same login window.

• Multiple Machines: Each activation code can be used on up to 3 different machines, however, the associated email 
will always be the email entered during your first activation. If you try to activate the same code on a 2nd machine 
with a separate email, the activation will fail.

• Trial Limitations: Only one trial can be requested per account or machine.

• The activation process is similar for trials and full licenses and is laid out below.

https://www.stltones.com/pages/file-downloads
http://www.stltones.com
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Full Perpetual License (Online Activation)

• When you first open the plugin, you will be prompted to log in to 
your STL Tones user account. 
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• You will receive an email to the address you provided from activations@stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the 
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.
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• You then will be prompted to activate a license. Select “Activate Product”.
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• This will take you to the activation screen. Enter your activation code and click “Activate”.
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Trial License (Online Activation) 

• When you first open the plugin, you will be prompted to log in to 
your STL Tones user account.
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• You will receive an email to the address you provided from activations@stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the 
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.
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• You then will be prompted to activate a license. Select “Activate Trial”.
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• Select “Activate Trial”.
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Input and Output Controls 

The Input control affects how much signal the plugin receives. This will affect the distortion range of the gain pots in 
the Amplifier and Stomp Sections. Adjust according to your purposes and input signal levels. The Output will affect 
how much signal the plugin sends out to your DAW channel. The meters will show if input or output signals are 
clipping by appearing red. NOTE: To make the virtual circuits react naturally to your guitar playing, it is vital to use the 
correct signal level, so we suggest using the input Level Listener feature located top-right of the input knob.

Input Level Listener: The Input Level Listener will assist in setting the plugin input level correctly.
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The preamp level on your sound card needs to be set correctly for the Input Level Listener to work as intended. It is 
advised to leave around 6dB of headroom on the A/D converter. In most cases, your sound-card input meters should 
peak below the "yellow" zone while playing normally. If the sound-card meters LEDs are mostly yellow or red 
(clipping), turn the preamp level down until you're in the "green" zone.

Once you open the Input Level Listener panel, the plugin analyzes your input signal and adjusts the Input Level 
control accordingly.

Once your input signal is set correctly, select the Pickup Type from the menu:

- Low Output is for single coil or vintage pickups with low sensitivity.
- Medium Output is for passive humbuckers with balanced output.
- High Output is for active or hot passive humbuckers.

Start playing and the software will adjust the input level according to your guitar signal and the selected Pickup Type.

Here are some reference values you should see in the Input Level Listener if you've set everything correctly. If you 
see values that are extremely different from the reference levels, please adjust the sound-card preamp and repeat the 
process:

- Low Output pickup: Input Level in the -6dB to -3dB range.
- Medium Output pickup: Input Level in the 0dB to +3dB range.
- High Output pickup: Input Level in the +6dB to +9dB range.



Main Interface                                                                                                                                          Page                                                                                                      19

Gate: Cuts unwanted noise spill, hiss, or hum by setting a threshold at which the input signal needs to be above for 
processing.  

Tuner: Click to open the Tuner. The tuning indicator light will span from left to right and turn green when the note is in 
tune (middle position). When using the Tuner, you can switch off the output sound of the plugin for convenience by 
clicking the speaker icon button on the bottom left side of the window. If you want to change the master tuning 
frequency to something other than 440Hz, you can do so by clicking on the reference text box on the bottom right 
side of the window. NOTE: Tuner runs in a modal window, so all the other controls in Tonality: Howard Benson are 
disabled until you close the Tuner window.
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Stomp Boxes: There are three available stomp pedal effects. 

Tube Screamer Stomp: There are 3 controls for the Tube Screamer Pedal:

1. DRIVE: Controls the amount of gain you are adding to the signal.

2. GAIN: Adjust the amount of volume you are adding to the signal.

3. TONE: Controls the amount of tonal frequencies you wish to add to the signal.

Delay: There are six controls for the delay pedal.

1. DELAY TIME: Sets the delay time. This value can be synced to the DAW by clicking the BPM SYNC button. You 
can also use the TAP button to tap tempo in a specific delay time of your choice.

2. LEVEL: Controls the mix of your signal from 0-100%. 100% is for an equal mix. The dry signal always passes 
unprocessed, when the mix is at 100%, the delayed signal has the same amplitude, therefore at 50%, the 
delayed signal is lower.

3. FEEDBACK: Controls the feedback and repeats of the Delay.

4. PRE/POST: Allows you to choose the delay position in the signal chain. Use PRE if you want the delay in front of 
the amp, or POST if you want it in the loop of the amp. NOTE: You can only use the effect in stereo mode when 
the switch is in POST mode.
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Reverb: There are four controls for the reverb pedal.

1. MIX: Controls the balance of the dry and wet signal.

2. DECAY: Sets the time of the reverb, from 0-10 seconds without temporal reference.

3. PRE DELAY: Controls the delay time before the reverberated signal appears.

4. PRE/POST: Allows you to choose the reverb position in the chain. Use PRE if you want the reverb in front of the 
amp, or POST if you want it in the loop of the amp. NOTE: You can only use the effect in stereo mode when the 
switch is in POST mode.
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Amplifier: Select between the six available amp models.
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AMP 1: Based on a Bogner© Uberschall™ amplifier, this German-voiced high gain amp has an aggressive punch. 
The unique Contour knob controls the saturation behavior. When turned up, the overall gain will increase in the high-
frequencies making the distortion more saturated.
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AMP 2: Based on a Wizard© Classic 50™ amplifier, this vintage Canadian amp with blistering high gain functionality 
is paired with the clean channel for modern vintage crunch. 



Main Interface (Amp Models)                                                                                                           Page                                                                                                      26

AMP 3: Based on a 1974 Marshall© Super Lead 100™ amplifier, this 60’s vintage British style amp has the speed 
and intensity for all styles of rock. The Bright knob controls the picking attack, making the tone brighter or darker/
softer depending on your needs. The Bright switch can help you to saturate the upper register of your tone.
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AMP 4: Based on a Fender© Super Reverb™ amplifier. Modeled from the circuitry of the iconic 100W 2x12 American 
clean amplifier. The Bright knob controls the picking attack, making the tone brighter or darker/softer depending on 
your needs. The Bright switch can help you to saturate the upper register of your tone.
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AMP 5: Based on a Fender© Bassman™ amplifier. Modeled from the world's most iconic amplifier from the ’50s. The 
Bright knob controls the picking attack, making the tone brighter or darker/softer depending on your needs. The Bright 
switch can help you to saturate the upper register of your tone.
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AMP 6: Based on an Ampeg© SVT 100™ amplifier. This revered vintage American bass amp remains an 
unmistakable part of the bass tones for many generations of musicians. The module has two channels, ‘Bright’ & 
‘Normal’.
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Cabinet Section: Click the cabinet icon to open the Cabinet view. Here, you can change the internal cabinets and 
internal IRs, as well as load external third-party impulse responses.
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Turning on the external impulse response loader turns off the internal IR.
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You can move the microphone around the speaker with 4 degrees of freedom: X (horizontal axis), Y (vertical axis), Z 
(distance), and W (angle). You can further tweak your tone by using the featured HPF/LPF pass filters, Resonance 
control, change the volume of each microphone by using the related volume slider, flip the phase with the related 
button, link options for Distance, HPF, LPF controls and set the mix of the 2 mics to find the perfect balance.

To get the most out of the Cabinet section, you can change the microphone distance and angle using the related 
knobs, however all 4 degrees of freedom are conveniently accessible directly via the crosshair by using key modifiers: 
left-clicking your mouse and dragging will move the microphone in the X/Y axis, left-clicking+ctrl and dragging will 
move the microphone on the Z axis, right-clicking and dragging will angle the microphone.

NOTE: You can bypass the cabinet section by clicking on the Cabinet icon in the footer controls while the Cabinet 
view is open. Enable the ‘lock’ icon to lock the current cabinet when changing amps via the Amp Selector Button.
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Standalone application

• Open the standalone app and click on the Audio I/O 
button.

• Select the MIDI inputs (device) connected to the 
computer you want to use.



MIDI                                                                                                                                                              Page 29                 

• Enable the MIDI Learn functionality by right-clicking on 
one of the Tonality plugin model's learnable controls, a 
popup menu will appear with two MIDI binding options:

MIDI Learn - Preset: This will store the MIDI bindings at the 
Preset level. Preset-level bindings have priority over Global 
Bindings, meaning that assigning a MIDI PC or CC 
message at the preset level will override existing bindings of 
the same messages at the Global level if any. Preset-level 
bindings are saved within the active preset and recalled 
when the preset becomes active. Remember to save the 
preset using the Preset Manager (check the Header 
Controls section) if you want to persist the MIDI bindings.

MIDI Learn - Global: This feature will store the MIDI 
bindings globally for the application/plugin. Global bindings 
are shared among presets, meaning the registered MIDI 
assignments will remain active even when changing presets 
(unless overridden by a Preset level assignment as 
described above).

• Once you select the binding type, the application will notify you that it’s ready to perform the assignment. Press the 
MIDI control you want to assign to the selected parameter/functionality on the MIDI controller and the binding will 
be stored, making the MIDI Learn popup menu disappear. You can now adjust that plugin parameter value using 
the connected MIDI controller.
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Using a MIDI message to change a preset

• If you want to recall a specific preset using your MIDI 
controller, all you need to do is load the preset you want 
to assign the MIDI message to, right-click on the preset 
menu located in the left section of the header, and select 
MIDI Learn - Global. This will trigger the previously 
described MIDI Learn functionality and the provided 
MIDI message will be bound to recall that preset. This is 
very useful in a live-playing situation.

• The same can be done with the Previous/Next Preset 
buttons placed on the sides of the preset menu if you 
want to use your MIDI controller to switch from a preset 
to the next or previous one without the need to reach 
your computer. These types of bindings can only be 
stored at the Learn Global level.

•  All stored MIDI assignments can be reviewed and modified in the MIDI settings panel, accessed by clicking on the 
MIDI icon in the plugin’s footer section.
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Resize: Click to resize the plugin interface. There are three possible values available: 50%, 75%, and 100%. In 
addition to these 3 modes, you can fine-tune the size using the resize function in the bottom right corner.

Presets: The preset manager is divided into 3 sections:

- Load: In the Load section you’ll find all the available banks where 
each bank entry has a submenu featuring all the presets it contains.

- Create: Under the Create section, you can either add a preset to 
the current bank or create a new bank entirely. When creating a new 
bank, the currently loaded preset will be copied into it, you can tweak 
it later using the edit options. 

- Edit: Under the Edit section, you can save changes to the current 
preset or bank file you are working on. NOTE: If you want to copy 
settings from one instance to another track in a DAW project, you 
can use the Edit > Current Preset > Copy function. 
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Tempo (BPM): Set the desired tempo for the plugin (Standalone mode only). NOTE: Tempo is saved at the preset 
level.

Routing: Tonality: Howard Benson supports three different routing modes: Mono, Mono/Stereo, and Stereo. 

- Mono: All the plugin sections will process the signal in mono.

- Mono/Stereo: All the plugin sections will process the signal in mono mode until an element supporting the “Mono-
To-Stereo-Split” is encountered. When this happens, the signal is split and the remaining elements in the chain will 
automatically switch to stereo processing. Delay and reverbs are typical models supporting the “Mono-To-Stereo-
Split”, so when using those pedals in Mono/Stereo routing mode, the signal will be split and the subsequent effects 
will work in stereo mode until the signal reaches the output.

- Stereo: All the plugin sections are internally doubled and will process the signal in stereo (left + right).

- Routing Lock: Click the lock icon in the current routing mode to audition different presets that maintain the routing 
untouched and avoid overrides. Since the routing mode is saved in the preset itself, loading a Preset will change it. 

NOTE: In the plugin versions of Tonality: Howard Benson, if the Routing menu only features the “Mono” option, you’ve 
most likely loaded it into a mono track. Use a stereo track if you want to enable the other routing options. Tonality: 
Howard Benson (standalone only) if the routing menu only features the “Mono” option, please check the setup in the 
output in the Audio I/O settings. Enable at least two outputs from the Audio I/O menu, close the application, and re-
open it. You should now see all the routing options available.
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For technical issues or any problems experienced with our software contact us via the contact page at 
www.stltones.com. 

Before doing so, follow our troubleshooting questions below to see if these fix your issue:

Support Information to be provided

• To help us assist you in the best way possible, please provide the following information to our support team:

• Product Version Number (e.g. Tonality: Howard Benson v1.7.0)

• Version number of your DAW (e.g ProTools 2021.12.0)

• Interface/hardware (e.g. Focusrite Scarlett 2i2, Universal Audio Apollo Twin, etc.)

• Computer and operating system info (e.g. Macbook Pro OS X 11.5.1, Windows 10 ver 1709, etc.)

• Please include a detailed description of your problem.
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Uninstall / Reinstall

This will repair possible broken permissions, fix corrupted files, and remove old versions of our software

Steps:

1. Close out of all host software (Pro Tools, Logic, Cubase, etc.)

2. Uninstall your plugin.

3. Open your host software and ensure that the plugins no longer showing up in the inserts list. If the plugins are still 
present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW 
(after restarting it), move on to step 4.

4. Close out of all host software.

5. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this 
manual making sure you have the latest installers for the plugin.

6. Run the latest installers and start your host program.

7. Follow the STL licensing prompts, ensuring that your host program is reading the latest version of our software.
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Repair permissions on your computer

Instructions: Run your host software as an administrator (Windows-only)

This can fix a variety of issues that result in crashing or error messages on Windows DAWs that are loading our 
plugins for the first time.

1. Exit your host program (Pro Tools, Cubase, etc.)

2. Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this 
once, meaning you can open up the host program normally the next time.
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How do I find my plugin in Reaper?

If you cannot find your STL Tonality: Howard Benson plugin in Reaper, follow these steps to make the plugin 
available:

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this 
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.

File Locations: Mac
VST: Macintosh HD/Library/Audio/Plugins/VST/STL Tonality - Howard Benson

File Locations: Windows
64-bit VST: C:\Program Files\VSTPlugins\STL Tonality - Howard Benson

If you don’t find the respective files please reinstall your STL Tonality: Howard Benson Product. If the relevant plugin 
files are in the above folder, perform a rescan:

1. In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.

2. Go to Plugins > VST

3. Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):
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Windows: 64-bit VST: C:\ Program Files \ VSTPlugins \ STL Tonality - Howard Benson

Mac: System HD > Library > Audio > Plugins > VST

Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track, and load your STL 
Tonality: Howard Benson plugin. If the pop-up window tells you to activate please press follow the installation and 
licensing procedure outlined in the “Installation & License Activation” section of this manual.
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How do I find my plugin in Pro Tools?

If you cannot find your STL Tonality: Howard Benson plugin in Pro Tools, follow these steps to make the plugin 
available.

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this 
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.

VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Howard Benson

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins /STL Tonality - Howard Benson

Windows: 64-bit VST: C:\Program Files\VSTPlugins\STL Tonality - Howard Benson
Windows: 64-bit AAX: C:\Program Files\Common\Files\Avid\Audio\Plugins\STL Tonality - Howard Benson

If you don’t find the respective files please reinstall your STL Tonality - Howard Benson Product. If the relevant plugin 
files are in the above folder, perform a rescan:

1. To do a Rescan, you must delete certain files on your computer depending on your Pro Tools version. Please 
follow the official Avid website to do this.
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The plugin makes no sound at all, why is this happening? 

You have most likely not activated the software yet, or the license file has moved to a different location and the 
software can’t find it anymore. Follow the installation and licensing procedure outlined in the “Installation & License 
Activation” section of this manual, making sure you have the latest installers for the plugin.

Where do I find the installers?

Visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.

Where is the STL Tonality Plugin located on my computer? 

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plugins / Components / STL Tonality - Howard Benson

VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Howard Benson

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins / STL Tonality - Howard Benson

Windows:

64-bit VST: C:\ Program Files \ VSTPlugins \ STL Tonality - Howard Benson

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plugins \ STL Tonality - Howard Benson

https://www.stltones.com/pages/file-downloads
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Plugin Development: Federico Berti (Ignite Amps)

Plugin GUI: Sonny Truelove and Dan Dankmeyer

Need more help?

Find technical support and instructions here: www.stltones.com/pages/contact-us

Contact our friendly Support Team here: www.stltones.com/pages/submit-a-request

Sincerely,

STL Tones Team


